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Understanding Embedded - FPGAs (Field
Programmable Gate Array)

Embedded - FPGAs, or Field Programmable Gate Arrays,
are advanced integrated circuits that offer unparalleled
flexibility and performance for digital systems. Unlike
traditional fixed-function logic devices, FPGAs can be
programmed and reprogrammed to execute a wide array
of logical operations, enabling customized functionality
tailored to specific applications. This reprogrammability
allows developers to iterate designs quickly and implement
complex functions without the need for custom hardware.

Applications of Embedded - FPGAs

The versatility of Embedded - FPGAs makes them
indispensable in numerous fields. In telecommunications,
FPGAs are used for high-speed data processing and
network infrastructure. In the automotive industry, they
support advanced driver-assistance systems (ADAS) and
infotainment solutions. Consumer electronics benefit from
FPGAs in devices requiring high performance and
adaptability, such as smart TVs and gaming consoles.
Industrial automation relies on FPGAs for real-time control
and processing in machinery and robotics. Additionally,
FPGAs play a crucial role in aerospace and defense, where
their reliability and ability to handle complex algorithms
are essential.

Common Subcategories of Embedded -
FPGAs

Within the realm of Embedded - FPGAs, several
subcategories address different needs and applications.
General-purpose FPGAs are the most widely used, offering
a balance of performance and flexibility for a broad range
of applications. High-performance FPGAs are designed for
applications requiring exceptional speed and
computational power, such as data centers and high-
frequency trading systems. Low-power FPGAs cater to
battery-operated and portable devices where energy
efficiency is paramount. Lastly, automotive-grade FPGAs
meet the stringent standards of the automotive industry,
ensuring reliability and performance in vehicle systems.

Types of Embedded - FPGAs

Embedded - FPGAs can be classified into several types
based on their architecture and specific capabilities. SRAM-
based FPGAs are prevalent due to their high speed and
ability to support complex designs, making them suitable
for performance-critical applications. Flash-based FPGAs
offer non-volatile storage, retaining their configuration
without power and enabling faster start-up times. Antifuse-
based FPGAs provide a permanent, one-time
programmable solution, ensuring robust security and
reliability for critical systems. Each type of FPGA brings
distinct advantages, making the choice dependent on the
specific needs of the application.
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Number of Logic Elements/Cells 92000
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Number of I/O 490

Number of Gates -

Voltage - Supply 1.14V ~ 1.26V

Mounting Type Surface Mount

Operating Temperature 0°C ~ 85°C (TJ)

Package / Case 1156-BBGA

Supplier Device Package 1156-FPBGA (35x35)
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PLL/DLL Cascading 
LatticeECP3 devices have been designed to allow certain combinations of PLL and DLL cascading. The allowable 
combinations are: 

• PLL to PLL supported 

• PLL to DLL supported 

The DLLs in the LatticeECP3 are used to shift the clock in relation to the data for source synchronous inputs. PLLs 
are used for frequency synthesis and clock generation for source synchronous interfaces. Cascading PLL and DLL 
blocks allows applications to utilize the unique benefits of both DLLs and PLLs. 

For further information about the DLL, please see the list of technical documentation at the end of this data sheet. 

PLL/DLL PIO Input Pin Connections 
All LatticeECP3 devices contains two DLLs and up to ten PLLs, arranged in quadrants. If a PLL and a DLL are next 
to each other, they share input pins as shown in the Figure 2-7.

Figure 2-7. Sharing of PIO Pins by PLLs and DLLs in LatticeECP3 Devices

Clock Dividers
LatticeECP3 devices have two clock dividers, one on the left side and one on the right side of the device. These are 
intended to generate a slower-speed system clock from a high-speed edge clock. The block operates in a ÷2, ÷4 or 
÷8 mode and maintains a known phase relationship between the divided down clock and the high-speed clock 
based on the release of its reset signal. The clock dividers can be fed from selected PLL/DLL outputs, the Slave 
Delay lines, routing or from an external clock input. The clock divider outputs serve as primary clock sources and 
feed into the clock distribution network. The Reset (RST) control signal resets input and asynchronously forces all 
outputs to low. The RELEASE signal releases outputs synchronously to the input clock. For further information on 
clock dividers, please see TN1178, LatticeECP3 sysCLOCK PLL/DLL Design and Usage Guide. Figure 2-8 shows 
the clock divider connections.

PLL

DLLDLL_PIO

PLL_PIO

Note: Not every PLL has an associated DLL.

www.latticesemi.com/dynamic/view_document.cfm?document_id=32318
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MULTADDSUBSUM DSP Element
In this case, the operands AA and AB are multiplied and the result is added/subtracted with the result of the multi-
plier operation of operands BA and BB of Slice 0. Additionally, the operands AA and AB are multiplied and the 
result is added/subtracted with the result of the multiplier operation of operands BA and BB of Slice 1. The results 
of both addition/subtractions are added by the second ALU following the slice cascade path. The user can enable 
the input, output and pipeline registers. Figure 2-30 and Figure 2-31 show the MULTADDSUBSUM sysDSP ele-
ment.

Figure 2-30. MULTADDSUBSUM Slice 0
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Figure 2-31. MULTADDSUBSUM Slice 1

Advanced sysDSP Slice Features
Cascading
The LatticeECP3 sysDSP slice has been enhanced to allow cascading. Adder trees are implemented fully in sys-
DSP slices, improving the performance. Cascading of slices uses the signals CIN, COUT and C Mux of the slice.

Addition
The LatticeECP3 sysDSP slice allows for the bypassing of multipliers and cascading of adder logic. High perfor-
mance adder functions are implemented without the use of LUTs. The maximum width adders that can be imple-
mented are 54-bit.

Rounding
The rounding operation is implemented in the ALU and is done by adding a constant followed by a truncation oper-
ation. The rounding methods supported are:

• Rounding to zero (RTZ)

• Rounding to infinity (RTI)

• Dynamic rounding

• Random rounding

• Convergent rounding 
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Programmable I/O Cells (PIC) 
Each PIC contains two PIOs connected to their respective sysI/O buffers as shown in Figure 2-32. The PIO Block 
supplies the output data (DO) and the tri-state control signal (TO) to the sysI/O buffer and receives input from the 
buffer. Table 2-11 provides the PIO signal list.

Figure 2-32. PIC Diagram
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Two adjacent PIOs can be joined to provide a differential I/O pair (labeled as “T” and “C”) as shown in Figure 2-32. 
The PAD Labels “T” and “C” distinguish the two PIOs. Approximately 50% of the PIO pairs on the left and right 
edges of the device can be configured as true LVDS outputs. All I/O pairs can operate as LVDS inputs. 

Table 2-11. PIO Signal List 

PIO 
The PIO contains four blocks: an input register block, output register block, tristate register block and a control logic 
block. These blocks contain registers for operating in a variety of modes along with the necessary clock and selec-
tion logic.

Input Register Block 
The input register blocks for the PIOs, in the left, right and top edges, contain delay elements and registers that can 
be used to condition high-speed interface signals, such as DDR memory interfaces and source synchronous inter-
faces, before they are passed to the device core. Figure 2-33 shows the input register block for the left, right and 
top edges. The input register block for the bottom edge contains one element to register the input signal and no 
DDR registers. The following description applies to the input register block for PIOs in the left, right and top edges 
only.

Name Type Description

INDD Input Data Register bypassed input. This is not the same port as INCK.

IPA, INA, IPB, INB Input Data Ports to core for input data

OPOSA, ONEGA1, 
OPOSB, ONEGB1

Output Data Output signals from core. An exception is the ONEGB port, used for tristate logic 
at the DQS pad.

CE PIO Control Clock enables for input and output block flip-flops.

SCLK PIO Control System Clock (PCLK) for input and output/TS blocks. Connected from clock ISB.

LSR PIO Control Local Set/Reset

ECLK1, ECLK2 PIO Control Edge clock sources. Entire PIO selects one of two sources using mux.

ECLKDQSR1 Read Control From DQS_STROBE, shifted strobe for memory interfaces only.

DDRCLKPOL1 Read Control Ensures transfer from DQS domain to SCLK domain.

DDRLAT1 Read Control Used to guarantee INDDRX2 gearing by selectively enabling a D-Flip-Flop in dat-
apath.

DEL[3:0] Read Control Dynamic input delay control bits.

INCK To Clock Distribution 
and PLL

PIO treated as clock PIO, path to distribute to primary clocks and PLL.

TS Tristate Data Tristate signal from core (SDR)

DQCLK01, DQCLK11 Write Control Two clocks edges, 90 degrees out of phase, used in output gearing.

DQSW2 Write Control Used for output and tristate logic at DQS only.

DYNDEL[7:0] Write Control Shifting of write clocks for specific DQS group, using 6:0 each step is approxi-
mately 25ps, 128 steps. Bit 7 is an invert (timing depends on input frequency). 
There is also a static control for this 8-bit setting, enabled with a memory cell.

DCNTL[6:0] PIO Control Original delay code from DDR DLL

DATAVALID1 Output Data Status flag from DATAVALID logic, used to indicate when input data is captured in 
IOLOGIC and valid to core.

READ For DQS_Strobe Read signal for DDR memory interface

DQSI For DQS_Strobe Unshifted DQS strobe from input pad

PRMBDET For DQS_Strobe DQSI biased to go high when DQSI is tristate, goes to input logic block as well as 
core logic.

GSRN Control from routing Global Set/Reset

1. Signals available on left/right/top edges only.
2. Selected PIO.
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Figure 2-33. Input Register Block for Left, Right and Top Edges

Output Register Block 
The output register block registers signals from the core of the device before they are passed to the sysI/O buffers. 
The blocks on the left and right PIOs contain registers for SDR and full DDR operation. The topside PIO block is the 
same as the left and right sides except it does not support ODDRX2 gearing of output logic. ODDRX2 gearing is 
used in DDR3 memory interfaces.The PIO blocks on the bottom contain the SDR registers but do not support 
generic DDR. 

Figure 2-34 shows the Output Register Block for PIOs on the left and right edges. 

In SDR mode, OPOSA feeds one of the flip-flops that then feeds the output. The flip-flop can be configured as a 
Dtype or latch. In DDR mode, two of the inputs are fed into registers on the positive edge of the clock. At the next 
clock cycle, one of the registered outputs is also latched.

A multiplexer running off the same clock is used to switch the mux between the 11 and 01 inputs that will then feed 
the output.

A gearbox function can be implemented in the output register block that takes four data streams: OPOSA, ONEGA, 
OPOSB and ONEGB. All four data inputs are registered on the positive edge of the system clock and two of them 
are also latched. The data is then output at a high rate using a multiplexer that runs off the DQCLK0 and DQCLK1 
clocks. DQCLK0 and DQCLK1 are used in this case to transfer data from the system clock to the edge clock 
domain. These signals are generated in the DQS Write Control Logic block. See Figure 2-37 for an overview of the 
DQS write control logic.

Please see TN1180, LatticeECP3 High-Speed I/O Interface for more information on this topic.

Further discussion on using the DQS strobe in this module is discussed in the DDR Memory section of this data 
sheet.
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Table 2-14. Available SERDES Quads per LatticeECP3 Devices

SERDES Block
A SERDES receiver channel may receive the serial differential data stream, equalize the signal, perform Clock and 
Data Recovery (CDR) and de-serialize the data stream before passing the 8- or 10-bit data to the PCS logic. The 
SERDES transmitter channel may receive the parallel 8- or 10-bit data, serialize the data and transmit the serial bit 
stream through the differential drivers. Figure 2-41 shows a single-channel SERDES/PCS block. Each SERDES 
channel provides a recovered clock and a SERDES transmit clock to the PCS block and to the FPGA core logic.

Each transmit channel, receiver channel, and SERDES PLL shares the same power supply (VCCA). The output 
and input buffers of each channel have their own independent power supplies (VCCOB and VCCIB).

Figure 2-41. Simplified Channel Block Diagram for SERDES/PCS Block

PCS
As shown in Figure 2-41, the PCS receives the parallel digital data from the deserializer and selects the polarity, 
performs word alignment, decodes (8b/10b), provides Clock Tolerance Compensation and transfers the clock 
domain from the recovered clock to the FPGA clock via the Down Sample FIFO.

For the transmit channel, the PCS block receives the parallel data from the FPGA core, encodes it with 8b/10b, 
selects the polarity and passes the 8/10 bit data to the transmit SERDES channel. 

The PCS also provides bypass modes that allow a direct 8-bit or 10-bit interface from the SERDES to the FPGA 
logic. The PCS interface to the FPGA can also be programmed to run at 1/2 speed for a 16-bit or 20-bit interface to 
the FPGA logic. 

Package ECP3-17 ECP3-35 ECP3-70 ECP3-95 ECP3-150

256 ftBGA 1 1 — — —

328 csBGA 2 channels — — — —

484 fpBGA 1 1 1 1

672 fpBGA — 1 2 2 2

1156 fpBGA — — 3 3 4
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SCI (SERDES Client Interface) Bus
The SERDES Client Interface (SCI) is an IP interface that allows the SERDES/PCS Quad block to be controlled by 
registers rather than the configuration memory cells. It is a simple register configuration interface that allows 
SERDES/PCS configuration without power cycling the device.

The Diamond and ispLEVER design tools support all modes of the PCS. Most modes are dedicated to applications 
associated with a specific industry standard data protocol. Other more general purpose modes allow users to 
define their own operation. With these tools, the user can define the mode for each quad in a design. 

Popular standards such as 10Gb Ethernet, x4 PCI Express and 4x Serial RapidIO can be implemented using IP 
(available through Lattice), a single quad (Four SERDES channels and PCS) and some additional logic from the 
core. 

The LatticeECP3 family also supports a wide range of primary and secondary protocols. Within the same quad, the 
LatticeECP3 family can support mixed protocols with semi-independent clocking as long as the required clock fre-
quencies are integer x1, x2, or x11 multiples of each other. Table 2-15 lists the allowable combination of primary 
and secondary protocol combinations. 

Flexible Quad SERDES Architecture
The LatticeECP3 family SERDES architecture is a quad-based architecture. For most SERDES settings and stan-
dards, the whole quad (consisting of four SERDES) is treated as a unit. This helps in silicon area savings, better 
utilization and overall lower cost.

However, for some specific standards, the LatticeECP3 quad architecture provides flexibility; more than one stan-
dard can be supported within the same quad.

Table 2-15 shows the standards can be mixed and matched within the same quad. In general, the SERDES stan-
dards whose nominal data rates are either the same or a defined subset of each other, can be supported within the 
same quad. In Table 2-15, the Primary Protocol column refers to the standard that determines the reference clock 
and PLL settings. The Secondary Protocol column shows the other standard that can be supported within the 
same quad.

Furthermore, Table 2-15 also implies that more than two standards in the same quad can be supported, as long as 
they conform to the data rate and reference clock requirements. For example, a quad may contain PCI Express 1.1, 
SGMII, Serial RapidIO Type I and Serial RapidIO Type II, all in the same quad.

Table 2-15. LatticeECP3 Primary and Secondary Protocol Support

Primary Protocol Secondary Protocol

PCI Express 1.1 SGMII

PCI Express 1.1 Gigabit Ethernet

PCI Express 1.1 Serial RapidIO Type I

PCI Express 1.1 Serial RapidIO Type II

Serial RapidIO Type I SGMII

Serial RapidIO Type I Gigabit Ethernet

Serial RapidIO Type II SGMII

Serial RapidIO Type II Gigabit Ethernet

Serial RapidIO Type II Serial RapidIO Type I

CPRI-3 CPRI-2 and CPRI-1

3G-SDI HD-SDI and SD-SDI
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SERDES Power Supply Requirements1, 2, 3

Over Recommended Operating Conditions

Symbol Description Typ. Max. Units

Standby (Power Down)

ICCA-SB VCCA current (per channel) 3 5 mA

ICCIB-SB Input buffer current (per channel) — — mA

ICCOB-SB Output buffer current (per channel) — — mA

Operating (Data Rate = 3.2 Gbps)

ICCA-OP VCCA current (per channel) 68 77 mA

ICCIB-OP Input buffer current (per channel) 5 7 mA

ICCOB-OP Output buffer current (per channel) 19 25 mA

Operating (Data Rate = 2.5 Gbps)

ICCA-OP VCCA current (per channel) 66 76 mA

ICCIB-OP Input buffer current (per channel) 4 5 mA

ICCOB-OP Output buffer current (per channel) 15 18 mA

Operating (Data Rate = 1.25 Gbps)

ICCA-OP VCCA current (per channel) 62 72 mA

ICCIB-OP Input buffer current (per channel) 4 5 mA

ICCOB-OP Output buffer current (per channel) 15 18 mA

Operating (Data Rate = 250 Mbps)

ICCA-OP VCCA current (per channel) 55 65 mA

ICCIB-OP Input buffer current (per channel) 4 5 mA

ICCOB-OP Output buffer current (per channel) 14 17 mA

Operating (Data Rate = 150 Mbps)

ICCA-OP VCCA current (per channel) 55 65 mA

ICCIB-OP Input buffer current (per channel) 4 5 mA

ICCOB-OP Output buffer current (per channel) 14 17 mA

1. Equalization enabled, pre-emphasis disabled.
2. One quarter of the total quad power (includes contribution from common circuits, all channels in the quad operating, 

pre-emphasis disabled, equalization enabled).
3. Pre-emphasis adds 20 mA to ICCA-OP data.
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sysI/O Differential Electrical Characteristics
LVDS25

Over Recommended Operating Conditions

Differential HSTL and SSTL
Differential HSTL and SSTL outputs are implemented as a pair of complementary single-ended outputs. All allow-
able single-ended output classes (class I and class II) are supported in this mode.

Parameter Description Test Conditions Min. Typ. Max. Units

VINP
1, VINM

1 Input Voltage 0 — 2.4 V

VCM
1 Input Common Mode Voltage Half the Sum of the Two Inputs 0.05 — 2.35 V

VTHD Differential Input Threshold Difference Between the Two Inputs +/–100 — — mV

IIN Input Current Power On or Power Off — — +/–10 µA

VOH Output High Voltage for VOP or VOM RT = 100 Ohm — 1.38 1.60 V

VOL Output Low Voltage for VOP or VOM RT = 100 Ohm 0.9 V 1.03 — V

VOD Output Voltage Differential (VOP - VOM), RT = 100 Ohm 250 350 450 mV

VOD 
Change in VOD Between High and 
Low — — 50 mV

VOS Output Voltage Offset (VOP + VOM)/2, RT = 100 Ohm 1.125 1.20 1.375 V

VOS Change in VOS Between H and L — — 50 mV

ISAB Output Short Circuit Current VOD = 0V Driver Outputs Shorted to 
Each Other — — 12 mA

1, On the left and right sides of the device, this specification is valid only for VCCIO = 2.5 V or 3.3 V.
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fMAX_GDDR DDRX1 Clock Frequency ECP3-70EA/95EA — 250 — 250 — 250 MHz

tDVBGDDR Data Valid Before CLK ECP3-35EA 683 — 688 — 690 — ps

tDVAGDDR Data Valid After CLK ECP3-35EA 683 — 688 — 690 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-35EA — 250 — 250 — 250 MHz

tDVBGDDR Data Valid Before CLK ECP3-17EA 683 — 688 — 690 — ps

tDVAGDDR Data Valid After CLK ECP3-17EA 683 — 688 — 690 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-17EA — 250 — 250 — 250 MHz

Generic DDRX1 Output with Clock and Data Aligned at Pin (GDDRX1_TX.SCLK.Aligned)10 

tDIBGDDR Data Invalid Before Clock ECP3-150EA — 335 — 338 — 341 ps

tDIAGDDR Data Invalid After Clock ECP3-150EA — 335 — 338 — 341 ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-150EA — 250 — 250 — 250 MHz

tDIBGDDR Data Invalid Before Clock ECP3-70EA/95EA — 339 — 343 — 347 ps

tDIAGDDR Data Invalid After Clock ECP3-70EA/95EA — 339 — 343 — 347 ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-70EA/95EA — 250 — 250 — 250 MHz

tDIBGDDR Data Invalid Before Clock ECP3-35EA — 322 — 320 — 321 ps

tDIAGDDR Data Invalid After Clock ECP3-35EA — 322 — 320 — 321 ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-35EA — 250 — 250 — 250 MHz

tDIBGDDR Data Invalid Before Clock ECP3-17EA — 322 — 320 — 321 ps

tDIAGDDR Data Invalid After Clock ECP3-17EA — 322 — 320 — 321 ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-17EA — 250 — 250 — 250 MHz

Generic DDRX1 Output with Clock and Data (<10 Bits Wide) Centered at Pin (GDDRX1_TX.DQS.Centered)10 

Left and Right Sides

tDVBGDDR Data Valid Before CLK ECP3-150EA 670 — 670 — 670 — ps

tDVAGDDR Data Valid After CLK ECP3-150EA 670 — 670 — 670 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-150EA — 250 — 250 — 250 MHz

tDVBGDDR Data Valid Before CLK ECP3-70EA/95EA 657 — 652 — 650 — ps

tDVAGDDR Data Valid After CLK ECP3-70EA/95EA 657 — 652 — 650 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-70EA/95EA — 250 — 250 — 250 MHz

tDVBGDDR Data Valid Before CLK ECP3-35EA 670 — 675 — 676 — ps

tDVAGDDR Data Valid After CLK ECP3-35EA 670 — 675 — 676 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-35EA — 250 — 250 — 250 MHz

tDVBGDDR Data Valid Before CLK ECP3-17EA 670 — 670 — 670 — ps

tDVAGDDR Data Valid After CLK ECP3-17EA 670 — 670 — 670 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-17EA — 250 — 250 — 250 MHz

Generic DDRX2 Output with Clock and Data (>10 Bits Wide) Aligned at Pin (GDDRX2_TX.Aligned)

Left and Right Sides

tDIBGDDR Data Invalid Before Clock All ECP3EA Devices — 200 — 210 — 220 ps

tDIAGDDR Data Invalid After Clock All ECP3EA Devices — 200 — 210 — 220 ps

fMAX_GDDR DDRX2 Clock Frequency All ECP3EA Devices — 500 — 420 — 375 MHz

Generic DDRX2 Output with Clock and Data (>10 Bits Wide) Centered at Pin  Using DQSDLL (GDDRX2_TX.DQSDLL.Centered)11

Left and Right Sides 

tDVBGDDR Data Valid Before CLK All ECP3EA Devices 400 — 400 — 431 — ps

tDVAGDDR Data Valid After CLK All ECP3EA Devices 400 — 400 — 432 — ps

fMAX_GDDR DDRX2 Clock Frequency All ECP3EA Devices — 400 — 400 — 375 MHz

LatticeECP3 External Switching Characteristics (Continued)1, 2, 3, 13

Over Recommended Commercial Operating Conditions

Parameter Description Device

–8 –7 –6

UnitsMin. Max. Min. Max. Min. Max.
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Figure 3-8. Generic DDRX1/DDRX2 (With Clock Center on Data Window)
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LatticeECP3 Internal Switching Characteristics1, 2, 5 
Over Recommended Commercial Operating Conditions

Parameter Description

–8 –7 –6

Units.Min. Max. Min. Max. Min. Max.

PFU/PFF Logic Mode Timing

tLUT4_PFU LUT4 delay (A to D inputs to F output) — 0.147 — 0.163 — 0.179 ns

tLUT6_PFU LUT6 delay (A to D inputs to OFX output) — 0.281 — 0.335 — 0.379 ns

tLSR_PFU Set/Reset to output of PFU (Asynchronous) — 0.593 — 0.674 — 0.756 ns

tLSRREC_PFU
Asynchronous Set/Reset recovery time for 
PFU Logic 0.298 0.345 0.391 ns

tSUM_PFU Clock to Mux (M0,M1) Input Setup Time 0.134 — 0.144 — 0.153 — ns

tHM_PFU Clock to Mux (M0,M1) Input Hold Time –0.097 — –0.103 — –0.109 — ns

tSUD_PFU Clock to D input setup time 0.061 — 0.068 — 0.075 — ns

tHD_PFU Clock to D input hold time 0.019 — 0.013 — 0.015 — ns

tCK2Q_PFU 
Clock to Q delay, (D-type Register 
Configuration) — 0.243 — 0.273 — 0.303 ns

PFU Dual Port Memory Mode Timing

tCORAM_PFU Clock to Output (F Port) — 0.710 — 0.803 — 0.897 ns

tSUDATA_PFU Data Setup Time –0.137 — –0.155 — –0.174 — ns

tHDATA_PFU Data Hold Time 0.188 — 0.217 — 0.246 — ns

tSUADDR_PFU Address Setup Time –0.227 — –0.257 — –0.286 — ns

tHADDR_PFU Address Hold Time 0.240 — 0.275 — 0.310 — ns

tSUWREN_PFU Write/Read Enable Setup Time –0.055 — –0.055 — –0.063 — ns

tHWREN_PFU Write/Read Enable Hold Time 0.059 — 0.059 — 0.071 — ns

PIC Timing

PIO Input/Output Buffer Timing

tIN_PIO Input Buffer Delay (LVCMOS25) — 0.423 — 0.466 — 0.508 ns

tOUT_PIO Output Buffer Delay (LVCMOS25) — 1.241 — 1.301 — 1.361 ns

IOLOGIC Input/Output Timing

tSUI_PIO
Input Register Setup Time (Data Before 
Clock) 0.956 — 1.124 — 1.293 — ns

tHI_PIO Input Register Hold Time (Data after Clock) 0.225 — 0.184 — 0.240 — ns

tCOO_PIO Output Register Clock to Output Delay4 - 1.09 - 1.16 - 1.23 ns

tSUCE_PIO Input Register Clock Enable Setup Time 0.220 — 0.185 — 0.150 — ns

tHCE_PIO Input Register Clock Enable Hold Time –0.085 — –0.072 — –0.058 — ns

tSULSR_PIO Set/Reset Setup Time 0.117 — 0.103 — 0.088 — ns

tHLSR_PIO Set/Reset Hold Time –0.107 — –0.094 — –0.081 — ns

EBR Timing

tCO_EBR Clock (Read) to output from Address or Data — 2.78 — 2.89 — 2.99 ns

tCOO_EBR
Clock (Write) to output from EBR output 
Register — 0.31 — 0.32 — 0.33 ns

tSUDATA_EBR Setup Data to EBR Memory –0.218 — –0.227 — –0.237 — ns

tHDATA_EBR Hold Data to EBR Memory 0.249 — 0.257 — 0.265 — ns

tSUADDR_EBR Setup Address to EBR Memory –0.071 — –0.070 — –0.068 — ns

tHADDR_EBR Hold Address to EBR Memory 0.118 — 0.098 — 0.077 — ns

tSUWREN_EBR Setup Write/Read Enable to EBR Memory –0.107 — –0.106 — –0.106 — ns
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HDMI (High-Definition Multimedia Interface) Electrical and Timing 
Characteristics
AC and DC Characteristics
Table 3-22. Transmit and Receive1, 2

Symbol Description

Spec. Compliance

UnitsMin. Spec. Max. Spec.

Transmit

Intra-pair Skew — 75 ps

Inter-pair Skew — 800 ps

TMDS Differential Clock Jitter — 0.25 UI

Receive

RT Termination Resistance 40 60 Ohms

VICM
Input AC Common Mode Voltage (50-Ohm Set-
ting) — 50 mV

TMDS Clock Jitter Clock Jitter Tolerance — 0.25 UI

1. Output buffers must drive a translation device. Max. speed is 2 Gbps. If translation device does not modify rise/fall time, the maximum 
speed is 1.5 Gbps.

2. Input buffers must be AC coupled in order to support the 3.3 V common mode. Generally, HDMI inputs are terminated by an external cable 
equalizer before data/clock is forwarded to the LatticeECP3 device.
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Figure 3-21. sysCONFIG Parallel Port Write Cycle

Figure 3-22. sysCONFIG Master Serial Port Timing

Figure 3-23. sysCONFIG Slave Serial Port Timing

CCLK 1

CS1N

CSN

WRITEN

BUSY

D[0:7]

tSUCS tHCS

tSUWD

tHCBDI

tDCB

tHWD

tBSCYC

tBSCH

tBSCL

tSUCBDI

Byte 0 Byte 1 Byte 2 Byte n

1.  In Master Parallel Mode the FPGA provides CCLK (MCLK). In Slave Parallel Mode the external device provides CCLK.
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DOUT
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CCLK (input) 
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Figure 3-24. Power-On-Reset (POR) Timing

Figure 3-25. sysCONFIG Port Timing
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1.  Time taken from VCC, VCCAUX or VCCIO8, whichever is the last to cross the POR trip point.
2.  Device is in a Master Mode (SPI, SPIm).
3.  The CFG pins are normally static (hard wired).
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sysI/O Differential Electrical Characteristics
Transition Reduced LVDS (TRLVDS DC Specification)

Over Recommended Operating Conditions

Mini LVDS
Over Recommended Operating Conditions

Symbol Description Min. Nom. Max. Units

VCCO Driver supply voltage (+/– 5%) 3.14 3.3 3.47 V

VID Input differential voltage 150 — 1200 mV

VICM Input common mode voltage 3 — 3.265 V

VCCO Termination supply voltage 3.14 3.3 3.47 V

RT Termination resistance (off-chip) 45 50 55 Ohms

Note: LatticeECP3 only supports the TRLVDS receiver.

Parameter Symbol Description Min. Typ. Max. Units

ZO Single-ended PCB trace impedance 30 50 75 Ohms

RT Differential termination resistance 50 100 150 Ohms

VOD Output voltage, differential, |VOP - VOM| 300 — 600 mV

VOS Output voltage, common mode, |VOP + VOM|/2 1 1.2 1.4 V

VOD Change in VOD, between H and L — — 50 mV

VID Change in VOS, between H and L — — 50 mV

VTHD Input voltage, differential, |VINP - VINM| 200 — 600 mV

VCM Input voltage, common mode, |VINP + VINM|/2 0.3+(VTHD/2) — 2.1-(VTHD/2)

TR, TF Output rise and fall times, 20% to 80% — — 550 ps

TODUTY Output clock duty cycle 40 — 60 %

Note: Data is for 6 mA differential current drive. Other differential driver current options are available.

Current 
Source

VCCO = 3.3 V

Z0

RT RTTransmitter

Receiver
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D7/SPID0 I/O Parallel configuration I/O. SPI/SPIm data input. Open drain during configura-
tion.

DI/CSSPI0N/CEN I/O Serial data input for slave serial mode. SPI/SPIm mode chip select. 

Dedicated SERDES Signals3

PCS[Index]_HDINNm I High-speed input, negative channel m 

PCS[Index]_HDOUTNm O High-speed output, negative channel m 

PCS[Index]_REFCLKN I Negative Reference Clock Input 

PCS[Index]_HDINPm I High-speed input, positive channel m 

PCS[Index]_HDOUTPm O High-speed output, positive channel m 

PCS[Index]_REFCLKP I Positive Reference Clock Input 

PCS[Index]_VCCOBm — Output buffer power supply, channel m (1.2V/1.5)

PCS[Index]_VCCIBm — Input buffer power supply, channel m (1.2V/1.5V) 

1. When placing switching I/Os around these critical pins that are designed to supply the device with the proper reference or supply voltage, 
care must be given. 

2. These pins are dedicated inputs or can be used as general purpose I/O.
3. m defines the associated channel in the quad. 

Signal Descriptions (Cont.)
Signal Name I/O Description 
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Pin Information Summary (Cont.)
Pin Information Summary ECP3-95EA ECP3-150EA

Pin Type 484 fpBGA 672 fpBGA 1156 fpBGA
672 

fpBGA
1156

fpBGA

Emulated 
Differential I/O 
per Bank

Bank 0 21 30 43 30 47

Bank 1 18 24 39 24 43

Bank 2 8 12 13 12 18

Bank 3 20 23 33 23 37

Bank 6 22 25 33 25 37

Bank 7 11 16 18 16 24

Bank 8 12 12 12 12 12

Highspeed 
Differential I/O 
per Bank

Bank 0 0 0 0 0 0

Bank 1 0 0 0 0 0

Bank 2 6 9 9 9 15

Bank 3 9 12 16 12 21

Bank 6 11 14 16 14 21

Bank 7 9 12 13 12 18

Bank 8 0 0 0 0 0

Total Single Ended/ 
Total Differential
I/O per Bank

Bank 0 42/21 60/30 86/43 60/30 94/47

Bank 1 36/18 48/24 78/39 48/24 86/43

Bank 2 28/14 42/21 44/22 42/21 66/33

Bank 3 58/29 71/35 98/49 71/35 116/58

Bank 6 67/33 78/39 98/49 78/39 116/58

Bank 7 40/20 56/28 62/31 56/28 84/42

Bank 8 24/12 24/12 24/12 24/12 24/12

DDR Groups 
Bonded 
per Bank

Bank 0 3 5 7 5 7

Bank 1 3 4 7 4 7

Bank 2 2 3 3 3 4

Bank 3 3 4 5 4 7

Bank 6 4 4 5 4 7

Bank 7 3 4 4 4 6

Configuration 
Bank8 0 0 0 0 0

SERDES Quads 1 2 3 2 4

1.These pins must remain floating on the board.
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Package Pinout Information
Package pinout information can be found under “Data Sheets” on the LatticeECP3 product pages on the Lattice 
website at http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3 and in the Diamond or ispLEVER 
software tools. To create pinout information from within ispLEVER Design Planner, select Tools > Spreadsheet 
View. Then select Select File > Export and choose a type of output file. To create a pin information file from within 
Diamond select Tools > Spreadsheet View or Tools >Package View; then, select File > Export and choose a 
type of output file. See Diamond or ispLEVER Help for more information.

Thermal Management 
Thermal management is recommended as part of any sound FPGA design methodology. To assess the thermal 
characteristics of a system, Lattice specifies a maximum allowable junction temperature in all device data sheets. 
Designers must complete a thermal analysis of their specific design to ensure that the device and package do not 
exceed the junction temperature limits. Refer to the Thermal Management document to find the device/package 
specific thermal values.

For Further Information
For further information regarding Thermal Management, refer to the following:

• Thermal Management document

• TN1181, Power Consumption and Management for LatticeECP3 Devices

• Power Calculator tool included with the Diamond and ispLEVER design tools, or as a standalone download from 
www.latticesemi.com/software

http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3.aspx
www.latticesemi.com/dynamic/view_document.cfm?document_id=210
www.latticesemi.com/dynamic/view_document.cfm?document_id=32321
http://www.latticesemi.com/products/designsoftware/index.cfm

